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Ako programovat vo Visual Basic for Applications
V niektorych pripadoch potrebujeme pouZivat funkcionalitu mimo rozsah tej, ktord pontka Microsoft

Excel. Uréitym sp6sobom ,,zachranuje situaciu” nahraté makro, ktoré je vsak primarne uréené na

zautomatizovanie ¢innosti v Exceli. Specifickt funkcionalitu si méZeme naprogramovat a to

prostrednictvom Microsoft Visual Basic for Applications. Microsoft Visual Basic for Applications je

,odlahcend” verzia programovacieho jazyka Microsoft Visual Basic.

Pre spristupnenie prostredia Microsoft Visual Basic for Applications si musime najprv zobrazit kartu

Developer a to cez File > Options. V otvorenom okne Excel Options vlavo zvolime moznost

Customize Ribbon a Uplne vpravo zaciarkneme Developer.

Excel Options ?
General @ Customize the Ribbon.
Formulas
) Choose commands from: (i Customize the Ribbon: (i
Proofing Popular Commands W Main Tabs b
Save
.i'] All Chart Types... ~ Main Tabs
tanguage + Borders » H
Advanced Calculate Mow
= Center
Fl Conditional Formatting » Formulas
) I_-g Connections Dat.a
Quick Access Toolbar 3 copy [ [#] Review
E Custom Sort...
Add-Ins ¥ cut = [| Developer
Trust Center A~ Decrease Font Size k Code
T Delete Cells... Add-Ins
W' Delete Sheet Columns Controls
= Delete Sheet Rows XML
=1 E-mail Add > > Modify -
3 Fill Calor » [ [/] Add-Ins
= Filter << Remove Background Remaval v
Font I-
A Font Color 3
Font Size 1~
ﬁ' Format Cells...
j Format Painter
Qﬁ Freeze Panes 3
A" Increase Font Size
j‘ﬂ Insert Cells...
Insert Function...
'J,f Insert Sheet Columns
j'ﬁ Insert Sheet Rows MNew Tab New Group Rename...
b ~Macros Customizations: Reset =
E Merge & Center
g Mame Manager w Import/Export ™ |
Karta Developer sa zvycajne umiestni ako posledna karta medzi ostatnymi.
& Q&=
“ Haome Insert Page Layout Formulas Data Review View Developer
L — |
ﬁ I:ﬂ 2 Record Macm[% ‘- == |~c. Z [ Properties E =3
= -
== = % 1 e
E Use Relative References === ool view Code & F
Visual Macros Add-lns  COM Insert Design Source
Ty M Securi  Run Dial @ p
Basic (4 Macro Security Add-Ins = Maode LIS ]
Code Add-Ins Controls




Ukladanie stiiboru
Narozdiel od starsich verzii Microsoft Excel musime stubor s makrom (¢i uz nahratym alebo
naprogramovanym) uloZit pod $pecialnym formatom a to: Excel Macro-Enabled Workbook.

Save As n
T L Skolenia » Excel VBA » v O Prehladavat: Excel VBA i
Usporiadat = Mowy priecinck == = (7]
% iCloud Drive ™ Mazov B D&tum dpravy
# | iCloud Fotky
1 M5 Bxcel VBA e-book 28.3.20157:35
%ﬂ kont_tab_excel_2010 1.6.2015 23:14

#&) Domaca skupina

1M Tento poditad

| Dokumenty
W' Hudba
= Obrazky
] E’raccwn.a F-r!ocha I s
File name: | Ylastnd funkcia na SUM v|
Save as type: |Excel Macro-Enabled Workbook v

Autori: Excel Workbook
e Foiccl Macro-Enabled Workbook k‘
Excel Binary Workbook

Excel 97-2003 Workbook
XML Data

Single File Web Page

= Hide Folders Web Page

Excel Template

I LKA oy [ e, o [y

Ikonka suboru vyzera nasledovne (sibor ma priponu .xIsm):
[
[ )

kont_tab_excel 2
010

T

Povolenie makier
Kvéli bezpecnosti je implicitne povolenie makier zakdzané (v minulosti sa prostrednictvom makier
spustali virusy). PouZivatel musi po otvoreni siboru makro daného suboru povolit.



FHE9-C-RO&

“Hnme Insert Page Layout Formulas Data Review View Developer
- I:_j_Q =3 Record Macro {.}@ — |_E:' 3 * % Properties E 3‘-[
=[] use Relative References — =g 5l View Code E
Visual Macros Add-lns  COM ! Source .
Basic A Macro Security Add-Ins 2 # Run Dialog "
Code Add-Ins Controls
E/] Security Warning Macros have been disabled. | Enable Content |
.

To ako bude Excel pristupovat k siborom obsahujlice makro zavisi od globalneho nastavenia Macro

Security v karte Developer.

E Record Macro

Insert Page Layo

ﬁ Use Relative References
Macros

i\, Macro SEcurilﬁ

Code

Yisual
Basic

Mdme na vyber nasledovné moZnosti:

Disable all macros without notification — zakaze vsetky makrd, notifikdcia sa nezobrazi

Disable all macros with notification — zakaZze vSetky makrd, notifikacia sa zobrazi

Disable all macros except digitally signed macros — zakaze vsetky makra okrem digitalne

podpisanych

Enable all macros (not recommended; potentionally dangerous code can run) — povoli vsetky makra

(neodporuca sa; potencionalne sa moze spustit nebezpecny kdd)

Trust Center

2 |

Trusted Publish

rusted Publishers Macro Settings
Trusted Locations
Disable all macros without notification

Trusted Documents Disable all macros with notification

Add-ins Disable all macros except digitally signed macros

ActiveX Settings
Developer Macro Settings

Macro Settings

Protected View |:| Trust access to the VBA project object model

() Enable all macros [not recommended; potentially dangerous code can run)




Prostredie Microsoft Visual Basic
Karta Developer > Visual Basic

Po zvoleni tlacidla Visual Basic dostaneme nasledovné okno:

| Microsoft Visual Basic for Applications - Book1 - [Module1 (Code)] = B
% Eile Edit View |Insert Format Debug Bun  Tools Add-Ins  Window Help Type a question for help - -8 X
HE-Ed 4 2@3a 9 » o HEFW - @ i cn A
Project - VBAProject ﬂ |IGeneraIl j |IDecIarationsi j
= gl | =
=% Solver (SOLVERXLAM)
=% VBAProject (Book1)

=] icrosoft Excel Objects

Sheet1 (Sheet1)

| Sheet? (Sheet2)
heet3 (Sheet3)
@ ThisWorkbook
-5 Modules

----- 22 Module1

Properties - Module1  X| SE. |
[Module1 Module ~] Immediate
Alphabetic

Categorized

\LIL v\it\W

4

1. Nalavo vidime tzv. Project Explorer, ktory obsahuju objekty otvoreného zosita (alebo zositov).
Napravo ndjdeme okno editora, kde budeme pisat (alebo po nahrani makra vidiet) samotny kod
VBA.

3. Okno, ktoré zobrazuje vlastnosti aktivneho objektu. VyuZijeme hlavne pri tvorbe formuldrov

Programovanie vo VBA
V principe mdzeme programovat dva typy programov

Sub = Subroutine = podprogram. Obsahuje prikazy Microsoft VBA, ktoré v Exceli vykonaju konkrétnu
¢innost (napr. vymazanie oblasti buniek, zluc¢enie, tvorba grafu, kontingencnej tabulky, ...).
Subroutine nevracia do bunky Ziadnu hodnotu.

Function = funkcia. . Obsahuje prikazy Microsoft VBA, ktoré vyuZijeme napr. k vytvoreniu vlastnej
funkcie (napr. obvod obdi#nika, vnutorny obvod riry a podobne). Function vracia navratov
hodnotu.

V obidvoch pripadoch za¢neme vloZzenim modulu a to zvolenim Insert a Module, tak ako to vyjadruje
nasledovny obrazok:



e |

i File Edit View

Insert | Format Debug Run

R Procedure... 3 9 )

4  Module !
@ Class Module m -

] Harok1 (Harok 1)
] Harok2 (Harok2)
] Harok3 (Harok3)
@ Tento_zodit
E& Modules

V Project Explorer sa zobrazi skupina Modules, ktora obsahuje modul s ndzvom Modulel.

% File Edit View Insert Format Debug

ME-"Jd + @38 90 » o
Project - VBAProject X|

&% Solver (SOLVERXLAM)
=-%% VBAProject (Book1)
El@ Microsaft Excel Objects
i L.EH] Sheet1A (Sheet1)
Sheet? (Sheet?)
B Sheet3 (Sheet3)
- L3k ThisWorkbook
=& Modules

Properties - Module’ il

Modulel Maodule -]

Alphabetic |Categurized |
Module1

V dalsom kroku prejdeme do Insert > Procedure...



(i

% File Edit View | Insert | Format Debug

@ - | ; | o Procedure...

Project - VBAProject | &8 UserForm
w? Module

&1 Class Module

%4 Solver (SOLVERXI
=-%% VBAProject (Boo File...

o 1

Mame na vyber z niekolkych moznosti. Podla situacie vyberieme Sub ak chceme vytvorit
podprogram (niekde oznacovana aj procedura) alebo Function, ak chceme vytvorit funkciu. Property
vyuzijeme na ziskanie alebo priradovanie vlastnosti objektov.

Add Procedure

Mame: | formatujTabulku|

Type
" Cancel |
* Sub

" Function

" Property

Scope
* public
" Private

[ All Local variables as Statics

Po potvrdeni mézeme do okna kddu pisat zdrojovy kod vo Visual Basic for Applications.
Formatovanie tabulky mo6ze vyzerat nasledovne:

Sub Macrol ()

:
' Macrol Macro
Al
ActiveCell.Range ("Al1:A3") .Select
Selection.Borders (x1DiagonalDown) .LineStyle = x1None
Selection.Borders (x1DiagonalUp) .LineStyle = x1None
With Selection.Borders (xlEdgeleft)
.LineStyle = xlContinuous
.ColorIndex = 0
.TintAndShade = 0
.Weight = x1Thin
End With



With Selection.Borders (xlInsideHorizontal)
.LineStyle = xlContinuous
.ColorIndex = 0
.TintAndShade = 0
.Weight = x1Thin
End With
Selection.Borders (x1DiagonalDown) .LineStyle = x1None
Selection.Borders (x1DiagonalUp) .LineStyle = x1None
With Selection.Borders (xlEdgeRight)
.LineStyle = xlContinuous
.ColorIndex = 0
.TintAndShade = 0
.Weight = x1Medium
End With
Selection.Borders (x1lInsideVertical) .LineStyle = x1None
With Selection.Borders(xlInsideHorizontal)
.LineStyle = x1lContinuous
.ColorIndex = 0
.TintAndShade = 0
.Weight = x1Thin
End With
End Sub

Jedna sa o tzv. subroutine.

Kopirovanie harka vyzerd nasledovne:

Sub kopirujHarok()

' kopirujHarok Macro

Sheets ("Sheetl") .Select

Sheets ("Sheetl") .Copy After:=Sheets(3)
End Sub

Formatovanie kddu
Pri kdde, ktory zapisujeme do editora by sme sa mali drzat nasledovnych odporucani:

e odsadenie
e prikazy piSeme do jednotlivych riadkov

Nevhodna ukazka formatovania kddu:

Sub kopirujHarok()
' kopirujHarok Macro

Sheetsz ("Sheetl™) .S5elect

Sheetz ("Sheetl"™) .Copy After:=5Sheetz(3)

End Sub

Vhodna ukazka formatovania kodu:
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Sub kopirujHarok()
]
' kopirujHarok Macro
]

Sheets ("Sheetl™) .5elect

Sheets ("Sheetl™) .Copy After:=5Sheets(3)
End Sub

Mobzeme pouzit panel Edit (menu View > Toolbar > Edit), kde ndjdeme Intend (odsadenie dolava)
alebo Outdend (odsadenie doprava)

Indent (Tak)

Nahravanie makra vs programovanie - efektivnost kodu

Makro, ktoré nahrdame ma vo vacsine pripadoch zbytoéne dlhy kéd. Porovnajme nasledovné rieSenia:
Kéd na vyfarbenie jednej bunky (prostrednictvom nahrdvania makra):

Sub vyfarbi ()

]
' vyfarbi Macro

With Selection.Interior
.Pattern = x1Solid
.PatternColorIndex = x1lAutomatic
.Color = 65535
.TintAndShade = 0
.PatternTintAndShade = 0

End With

End Sub

Ako by sme to mohli naprogramovat my:

Sub vyfarbi ()

' vyfarbi Macro

ActiveCell.Interior.Color = 65535
End Sub

Tvorba vlastnej funkcie (function)

Aj ked Microsoft Excel obsahuje velké mnoZstvo funkcii (SUM, AVERAGE, MIN, MAX, COUNT, IF, ...),
niekedy je potrebné v praxi pouZit svoju vlastnt (napr. obvod obdiZnika, vnitorny objem rury). Na
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vytvorenie vlastnej funkcie vyuZijeme makro, ktoré si naprogramujeme v Microsoft Excel VBA. VBA =
Visual Basic for Applications.

Ukdazku si predvedieme na vytvorenie vlastnej funkcie séitania dvoch buniek.

V karte Developer zvolime tlacidlo Visual Basic.
Do neho zapiSeme nasledovny zdrojovy kdd:

Function obvodObdlznika (stranaZA, stranaB)
obvodObdlznika = 2 * (stranalA + stranaB)
End Function

Zdrojovy kéd obsahuje anglické slova (prikazy, ktorym rozumie Microsoft Excel VBA) a slovenské
slova, ktoré sme zadali my.

Function obvodObdlznika (stranaZ, stranaB) —je nasvlastny nazov funkcie (bez
medzier a diakritiky), ktori potom pouZijeme v harku. Obsahuje dva argumenty (premenné):
stranalA pre oznacenie prvej bunky, s ktorou pocitame a stranaB pre oznacenie druhej bunky.

obvodObdlznika = 2 * (stranalA + stranaB)- Excel VBA vypocita obvod na zaklade
vzorca, ktory sme zadali a vysledok ,,odovzda“ do premennej s ndzvom obvodObdl znika. Nazov
premennej obvodObdlznika musi byt identicky s ndzvom, ktory sme poutzili pri prikaze
Function obvodObdlznika (stranalZA, stranaB)

End Function —tymto prikazom konéi funkcia

V Exceli vlozime nami definovanu funkciu podobne ako jednu z dalSich existujucich, vid obrazok

nizsie:
Insert Function ?

Search for a function:

Type a brief description of what you want to do and then dick Go

Go

Cr select a category: | User Defined |E|

Date &Ti

Select a function: MZih &'I'?; ~

Statistical

porovnajCisla
pripocitajJednoCislo
sctajCisla
scitajDveCisla

nasobGisla(bunky)|

Mo help available.

Lookup &Reference

Database
T

ext
Logical
Information

Cube
Compatibility

SolverAdd
SolverDelete De k.
Engineering

W

Help an this function

Cancel
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Doplnenie pomocnika k pouzivatel'skym funkciam
Karta Developer > Macros

V karte Developer vyberieme tlacidlo Macros. Ak sa nami vytvorena funkcia v zozname nenachadza,
je potrebné ju vypisat (musime mat vsak otvoreny subor, kde sa dané makro nachadza). Ak sa nazov
funkcie v zozname nachddza, tlacidla napravo sa zaktivnia. Vyberieme Options...

2
Macro :
Macro name:
ecitajDveCisla| s Run
Step Into
Edit
Delete
Options...
Macros in: | Viastna funkda na SUM, xls W
Description
Cancel
- 2
Macro Options :
Macro name:
scitajDveCisla
Shortout key:
Cirl+
Description:
Funkcia séita dve disla.
Ok % Cancel

Co je premenna
Premennd je do¢asné miesto v pamati, ktoru vyuZijeme na ukladanie lubovolnej hodnoty. Kazda

premenna ma nazov pozostavajuci z alfanumerickych znakov.



Nazov premennej by mal logicky nadvazovat na to, ¢o obsahuje (napr. dph, obrat, vysledok, bunkal,
chybovaSprava a podobne). Zapis je potom nasledovny:

dph = 1.19

obratDph = obrat * dph

chybovaSprava = “Pozor! Zadali ste hodnotu mimo rozsah!”
Premennu deklarujeme prikazom Dim, napr.

Dim obratDph As Double

Double je vlastne datovy typ, ktory reprezentuje desatinné ¢islo. Premenna by nemala nadobudat
iny typ udajov, inak dojde k chybe.

Deklaracia typu premennej nie je zavazna, no kvoli ¢itatelnosti a prehlfadnosti kdédu odpordéam
pouzit nastavenie Require Variable Declaration v okne Options, menu Tools.

Tools | Add-Ins  Window Help
ﬁ'; References...

[ BT
]
i}
]
]
]

Macros...

Dptions...
YEAProject Properties...
Digital Signature...

Options

Editor | Editor Format] General ] Docking ]

Code Settings

[v Auto Syntax Check v Auto Indent
v Require Variable Dedaration;

’ Tab Width: |4
[+ Auto List Members I}, -

[v Auto Quidk Info
v Auto Data Tips

Window Settings
[+ Drag-and-Drop Text Editing
[v Default to Full Module View
[+ Procedure Separator

K | Frusit’ Pomocnik
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Datové typy

Datovy typ Pocet bytov Rozsah hodnot
Boolean 2 True alebo False
Integer 2 -32,768 do 32767
Long 4 -2,147,483,648 do 2,147,483,647
Single 4 -3.402823E38 do 1.401298E45
Double 8 -1.79769313486232E308 do -
(negative) 4.94065645841247E-324
Double 8 4.94065645841247E-324 do
(positive) 1.79769313486232E308
Currency 8 -922,337,203,685,477.5808 do

922,337,203,685,477.5807

Date 8 1/1/100 to 12/31/9999
String 1(ak 1 znak)  Velkost zavisi od po¢tu znakov
Object 4 Akykolvek definovany objekt
Variant Variabilny Akykolvek datovy typ
Used defined  Variabilny Variabilny

Zrovnanie datového typu VBA s formatom bunky v MS Excel

Visual Basic for Application Excel

Byte (nemad)
Boolean (nem3)
Integer Cislo

Long Cislo

Date Datum
Object (nema)
String Text
Variant Vseobecny
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Vypisovanie hodnot (MsgBox, Debug.print)

Pouzijeme v pripade, ak chceme pouzivatelovi vypisat v okne spravu. Podla typu odpovede (tlacidla)

mobzeme dalej spracovat odpoved.

Microsoft Excel

Potvrdenim wytvorime graf!

Prikaz, ktory sme pouZili:

MsgBox "Potvrdenim vytvorime graf!"

Syntax prikazu

MsgBox (prompt, buttons ,

title,

helpfile, context)

prompt — povinny parameter. Je vlastne retazec, ktory sa v okne zobrazi

buttons — nepovinny parameter. Obsahuje cislo typu tlacidla podla ktorého sa tlacidlo bude

zobrazovat.

Vybrané typy tlacidiel

Constant Value Description

vbOKOnly 0 Display OK button only.

vbOKCancel 1 Display OK and Cancel buttons.
vbAbortRetrylgnore 2 Display Abort, Retry, and Ignore buttons.
vbYesNoCancel 3 Display Yes, No, and Cancel buttons.
vbYesNo 4 Display Yes and No buttons.
vbRetryCancel 5 Display Retry and Cancel buttons.
vbCritical 16 Display Critical Message icon.
vbQuestion 32 Display Warning Query icon.
vbExclamation 48 Display Warning Message icon.
vbInformation 64 Display Information Message icon.

title — nepovinny parameter, zobrazi okno nami definovanym nadpisom

helpfile — nepovinny parameter, obsahuje odkaz na sibor pomocnika

context —nepovinny parameter hesla zo siboru pomocnika

Navratova hodnota

16



Constant Value Description

vbOK 1 OK
vbCancel 2 Cancel
vbAbort 3 Abort
vbRetry 4 Retry
vbignore 5 Ignore
vbYes 6 Yes
vbNo 7 No
Priklad

Sub m=gBoxGraf ()
Dim odpoved &= Integer
Dim otazka As String
Dim titulok &= String
' Promt
otazka = "Prajete =5i wytvorit graf?"”
' Dialog's Title
titulok = "Graf"
'Display MessageBox
odpoved = M=s=gBox (otazka, wbYesHNo, titulok)
' Check pressed button
If odpoved = wbNo Then
M=gBox "Odpowvedali ste HIE!™
Else
M=gBox "Odpowvedali ste ANO
End If
End Sub

Graf “

Prajete si vytvorit graf?

Na vypisovanie hodn6t méze pouzit prikaz:

Debug.Print

Priklad:

Debug.Print "Aktudlna hodnota DPH je " & dph

Narozdiel do MsgBox, vystupnu hodnotu zobrazi v Immediate Window

17



Sub ShowVatImMediateWindow()
Dim dph As Double

dph = 0.2
Debug.Print "Aktualna hodnota DPH je " & dph
End Sub
=J= 4] |
Immediate

Lktualna hodnota DPFH je 0,2

| |

Pozndmka: Immediate Window mdzeme zobrazit/skryt cez View > Immediate Window)

&

% File Edit | Wiew | Insert Format Debug Ru
5 E - | Code Fr

; 5| Object Shift+F7
Project - VBAP| & Obiee | 0
= B Definition Shift+F2 |

Last Position  Ctrl+5Shift+F2
Object Browser F2

Immediate Window  Ctrl+G

5

Locals Window

Vstup hodnoty prostrednictvom okna
Pri MsgBox sme smerom k pouzivatelovi vypisali nejaku sprdvu, no v niektorych pripadoch
potrebujeme, aby pouzivatel zadal hodnotu, ktord chceme dodatocne spracovat

Microsoft Excel “
Zadajte svoje meno a priezvisko
Cancel

IJE‘In Fitriiak

Prikaz, ktory sme poutzili:
InputBox "Zadajte svoje meno a priezvisko"

18



Syntax prikazu
InputBox (prompt, title, default, left, top, helpfile, helpcontextid,
najdoleZitejsie parametre
prompt — povinny parameter. Je vlastne retazec, ktory sa v okne zobrazi
title — nepovinny parameter. Titulok okna
default — vychodzia hodnota, ktoru vopred Excel vypise
Odpoved mdzeme spracovat napr. takymto spésobom
Sub ZadajEmail ()
Dim odpoved 4= S5tring
odpoved = InputBox ("Zadajte Va3 e-mail™, "Vstupné uadaje™, "@™)

M=gBox ("Zadali ste e-mail " & odpoved)
End Sub

Ukdazka pouZitia a spracovania InputBox

Vstupné Udaje “
Zadajte Va: e-mail

Cancel

jan zitniak @gmail com|

Microsoft Excel “

Zadali ste e-rnail jan.zitniak@gmail.com

NajpouZzivanejSie funkcie (textové, matematické, logické, datumové a

cyklické)
Excel VBA obsahuje mnoZstvo funkcii, my si vypiSeme niektoré z nich.
Zdroj: http://www.excelfunctions.net/VBA-Operators-And-Functions.html

type)
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Funkcia

Abs

Case

Chr

Date

DateAd

Kategoria

Akcia ”
funkcii
Vrati absoldtnu hodnotu z Cisla. Priklad: Matemati
Abs(-10) vrati 10 cké
Abs (10) vrati 10
Nahradza poutzitie funkcie IF (vid'If). Logické
Funkciu zapisujeme cez: Select Case (podmienka)
Jednotlivé podmienky vypisujeme cez Case Is (ekvivalent Else If). Ak
neplati Ziadna z nich, tak plati podmienka uvedend v Case Else
Priklad:
Function AkeCisloCase (ci=slao)
Select Case ci=lo
Case I= < 0
AkeCi=sloCase = "Zaporngé™
Case I= > 0
LkeCisloCase = "Hladné"
Ca=e El=se
AkeCisloCase = "Hezdporng"
End Select
End Function
Vrati prislusny znak podla hodnoty v ASCIl tabulke. Vhodné pre Textové
zobrazenie Specialnych znakov (€, 6, © a podobne).
Priklad
Char(10) vrati novy riadok
Char(97) vrati znak ,,a“
Zdroj znakov ASCII http://www.asciitable.com/
Vrati aktudlny datum Datumové
Pripocita Specificky ¢as k datumu. Format funkcie je: Datumové

DateAdd(Interval, Number, Date),

interval — typ argumentu
number — pocet (hodin, dni, rokov, ...) o kolko pripocita k datumu

date — datum, ku ktorému sa pripocitava
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DateDif
f

Day

Legenda ku interval

Interval Reprezentuje
yyyy Year (rok)
q Quarter (Stvrtrok)
m Month (mesiac)
y day of the year (den roku)
d Day (den)
w Weekday (pracovny deni)
wWWw Week (tyzden)
h Hour (hodina)
n Minute (minuta)
s Second (sekunda)
Priklad:

DateAdd("d", 1, "1.6.2015") - prida 1 den k datumu 1.6.2015
DateAdd("ww", 2, "1.6.2015") - prida 2 tyZdne k ddtumu 1.6.2015

Vypocita pocet (interval) medzi ddtumami. Format funkcie je: Datumové

DateDiff(Interval, Date, Date),
interval — typ argumentu (vid tabulku vyssie pri DateAdd)

datel — datum
date2 — datum

Priklad:

DateDiff("d", "1.6.2015", "1.7.2015") - zisti pocCet dni medzi 1.6.2015
a1.7.2015

DateDiff("w", "1.6.2015", "1.7.2015") - zisti pocet vikendov medzi
1.6.2015a 1.7.2015

Vrati den z datumu. Datumové

Priklad:
Day ("28.7.2015") - vrati 28
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For

Foreach

Hour

Vhodne pri tvorbe opakujuceho sa prikazu/prikazov

Priklad:
Sub VyplnRiadky ()
Dim riadok A= Integer
For riadok = 1 To &
Cell=(riadok, 1).Value = 100
Hext riadok
End Sub

Vysledok: Vyplni prvych $est riadkov v prvom stipci (teda od Al do A6)
Sub VyplnRiadky ()

Dim riadok, aktBRiadok, aktStlpec 4= Integer
aktRiadok = ActiwvelCell.Row
aktS5tlpec = ActivelCell.Column
For riadok = aktRiadok To aktRiadok + &
Debug.Print (riadok)
Cells({riadok, aktStlpec).Value = 100
Hext riadok
End Sub

Vysledok: Vyplni Sest riadkov vzhladom na aktudlnu poziciu oznacenej
bunky

Prechdadza kolekciu Udajov bez toho, aby vedela kolko ich je (narozdiel
od For, kde zadavame konecny pocet)

Priklad:

Function scitajCisla (bunky A= Range)
Dim aktBunka A= Range
For Each aktBunka In bunky
scitajlfisla = scitajlisla + aktBunka.Value
Hext aktBunka
End Function

Vysledok: S¢ita oznacené bunky (ekvivalent SUM)

Vrati hodinu z ¢asu.
Priklad:
Hour("22:45:00") - vrati 22

Ekvivalent k funkcii IF prakticky s flubovolnym poctom. Argumentom je
podmienka. Ak je podmienka splnena, vrati TRUE, v opa¢nom pripade
FALSE.

Pozndmka: Prikaz If sa pouziva v spojeni s prikazom:

Then - ak je podmienka splnenad, tak sa vykona ...

Else — v opacnom pripade sa vykona ...

Elself — je vlastne vnorené If. Ak neplati hlavné podmienka, tak ...

Cyklické

Cyklické

Datumové

Logické

22



End If — koniec pouZivania If

Priklad:
Function AkeCislo(ci=zlao)
If ci=lo > 0 Then ' dalsi prikaz len do noveho riadka!
LkeCislo = "Hladnaé™
El=zelf ci=lo < 0 Then ' dalsi prikaz len do noveho riadk:
AkeCi=zlo = "Zaporné"™
El=ze ' dal=si prikaz len do noveho riadka!
AkeCizlo = "Hezidporné"
End If

End Function

VypiSe odpoved podla toho, ¢i je hodnota kladna, zaporna alebo
nezdporna

Pozndmka: Mézeme kombinovat spolu s AND, OR a dal$imi logickymi
funkciami, napr.:

Function AkeCislo(ci=lo)
If cislo >= 0 And cislo <= 100 Then
AkeCislo = "Cislo je v rozsahu od 0 do 100"
End If
End Function

InStr Vracia poziciu hladaného retazca v retazci. Hfadanie zadina na zadanej Textové

pozicii.

Priklad:

InStr(1, "Here is the searchword", "searchword") - slovo searchword
nasiel, preto vrati hodnotu 13

InStr(14, "Here is the searchword but here is another searchword",
"searchword") - slovo searchword nasiel, hlada v3ak od pozicie 14,
preto 44

InStr(1, "www.google.com", ".sk") - slovo .sk nenasiel, vysledok je O

Int Vrati celé Cislo (nie zaokruhlené) z desatinného Cisla Matemati
Priklad: cké
Int(5.79) — vrati hodnotu 5

IsDate Skontroluje, ¢i sa jednd o datum. Vracia TRUE ak hodnota je datum, Datumové
v opacnom pripade FALSE
IsDate("01/01/2015") — hodnota JE datum, preto vrati True
IsDate(100) — hodnota NIE JE datum, preto vrati False
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IsError

IsNume

ric

Left

Len

Month

Skontroluje, ¢i bunka obsahuje chybu. Ak ano, vrati TRUE, v opacnom
priprade FALSE.

Priklad:

Subk Macrol)
Dim cell 4= range
For Each cell In range("A1:B3")
If I=Error(cell) Then
M=gBox ("Error™)
End If
Hext cell
End Sub

Skontroluje ¢i hodnota je Ciselna alebo nie. Ak dno, vrati TRUE,
v opacnom pripade FALSE.

Priklad:
Sub CheckIsMumerici)
Dim MyVar, MyCheck

HMyvVar = "53" ' Assign wvalue.

HMyCheck = IsNumeric (MyVar) ' Returns True.

HMyVar = "458.35" ' Assign wvalue.

HMyCheck = IsNumeric (MyVar) ' Returns True.

HMyVar = "45 Help™ ' Assign wvalue.

HMyCheck = IsNumeric (MyVar) ' Returns False.
End Sub

Vrati v hladanom retazci Specificky pocet znakov ato zlava (od
zaciatku). Format funkcie je nasledovny:

Left(String, Length)

String — retazec, v ktorom hladame

Length — pocet znakov, ktoré vrati

Priklad:
Left("abcdefghijklm", 4) - vrati retazec "abcd"
Left("abcdefghijklm", 1) - vrati retazec "a"

Vrati pocet znakov retazca.
Priklad:

Len("abcdefg") - vrati 7, pretoZe je to 7 znakov

Vrati mesiac z datumu.
Priklad:
Month ("28.7.2015") - vrati 7

Logické

Logické

Textové

Textové

Datumové

24



Mid

Minute

Now

Right

Round

Second

Sqr

Vrati Cast textu z textového retazca na zaklade pozicie odkial a poétu

znakov. Format je nasledovny:

Mid(String, Start, Length)

String — textovy retazec, z ktorého vyberieme Cast textu
Start — Startovacia pozicia, z ktorej vyberieme text
Length — pocet znakov, ktoré chceme vybrat

Priklad:
Mid("abcdefghijklm", 4, 5) — vrati retazec "defgh"
Mid("abcdefghijklm", 10, 2) — vrati retazec "jk"

Vrati mindty z casu.
Priklad:
Minute (''22:45:15"") - vrati 45

Vrati aktudlny systémovy datum a cas

Vrati v hladanom retazci Specificky pocet znakov ato zprava (od
konca). Format funkcie je nasledovny:

Right(String, Length)

String — retazec, v ktorom hladame

Length — pocet znakov, ktoré vrati

Priklad:
Right("abcdefghijklm", 4) — vrati retazec "jkim"

Right("abcdefghijklm", 1) — vrati retazec "m"

Zaokruhli ¢islo na konkrétny pocet desatinnych miest
Priklad:

Round(5.79, 1) — zaokruhli ¢islo na 1 desatinné miesto, vysledok je 5,8

Vrati sekundy z ¢asu.
Priklad:
Second ("22:45:15") - vrati 15

Vrati druhd odmocninu z Cisla
Priklad:
Sqr(4) — vrati Cislo 2

Textové

Datumové

Datumové

Textové

Matemati

cké

Datumové

Matemati

cké
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Sqr(16) — vrati Cislo 4

Time Vrati aktudlny systémovy cas
Year Vrati rok z dadtumu.
Priklad:

Month ("28.7.2015") - vrati 2015

Matematické operacie s Cislami

Datumové

Datumové

Operator Poznamka Priklad Vysledok

+ Scitanie =7+2 =9

- Odcitanie =7-2 =5

& Ndsobenie =7%*2 =14

/ Delenie =7/2 =3,5

\ Celociselné delenie =7\2 =3
(vracia celd cast)

Mod Podiel (vracia zvy$ok po =7 mod 2 =1
deleni)

o Umocnovanie =) N3 =8

Spajanie retazcov

V Excel VBA nendjdeme funkciu CONCATENATE tak ako to pozndme v Exceli. Na spajanie retazcov

pouzijeme znak:
&

Priklad:

Sub VypisDEH()

Dim dph As Double
Dim sprava As String
sprava = "Lktuélna DPFH je ™

dph = 0.2 * 100

Debug.Print sprava & dph & "3"

End Sub

Vypise: Aktudlna DPH je 20%

With...End With

Zefektiviiuje zapis zdrojového kddu.

Zvazme nasledovny kod:
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Public Sub zmenPizmo ()
ActiveCell.Font.Bold = True
ActiveCell.Font.Color = wvbBlue

ActiveCell.Font.Hame = "Arial"™

ARctiveCell.Font.5ize = 22

ActiveCell.Font.Italic = True
End Subl

Rychlejsie ho mdzeme zapisat nasledovny spdsobom:

Public Sub zmenPismo ()
With ActiwveCell.Font
.Bold = True
.Color = vbBlue
.Hame = "Arial"™
.S5ize = 22
Italic =
End With

End Sub

Komentare

Pouzijeme v pripade vkladania poznamky do zdrojového kédu. SlUzi na popis funkcionality. Na

poznamky pouzijeme znak:
‘ — apostrof

Sub VypisDPH()

Dim dph As Double ' Deklaracia premennej typu desatinne cislo

Dim sprava As String ' Deklaracia premennej typu retazec

sprava = "Aktualna DPH je "™ ' Naplnime premennu textom

dph = 0.2 * 100 ' Excel VBA nepozna percenta, preto masime pouzit desatinne

Debug.Print sprava & dph & "3%" ' Zlucime vsetky premenne a vypiseme wvysledok do konzoly
End Sub

MoézZeme pouZit panel Edit (menu View > Toolbar > Edit), kde ndjdeme Comment Block (pridanie

komentara) alebo Uncomment Block (zrusenie poznamok)

& =

Comment Block

RIEan
i

T 0 b W a2 EE = 47

To som

Objekty

Vo Visual Basicu for Application existuje niekolko typov objektov:
Application Aplikdcia

Workbook Zosit

Worksheet Harok (List)
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Range Bunka v harku alebo oblast buniek

Cells Bunka v harku alebo oblast buniek - iny format zapisu
UserForm Formular

Module Modul vo VBA

Class Module

Modul triedy vo VBA

Ukazka kodov - prikladov na objekty

Nazov objektu vSeobecne

Praktické pouzitie Vystup

Funkce MsgBox - Okno so
spravou v kdde

MsgBox "Microsoft Excel" VypiSe okno: "Microsoft Excel"

Workbook — Zosit xlsx

Workbooks("cogs.xls").Open Otvori zosit s ndzvom "cogs.xlIs"

Sheets - Harok xlsx

Sheets("Harok1").Select Oznadi harok s ndzvom Harok1

Range - Bunka

Range("B3") = "Pondelok" Do bunky "B3" bude priradend

hodnota "Pondelok"

Range("B3:B10").Select Vyberie bunky B3 az B10

Vybraté akcie s bunkou

Su priradené k objektom alebo prvkom

Akcia Popis Prvok Syntax
AddComment vloz komentar bunka Range("B20").AddComment
Clear vymaze obsah i bunka Range("B20").Clear

format
ClearComments vymaz komentar bunka Range("B20").ClearComments
ClearContents vymaz obsah bunka Range("B20").ClearContents
ClearFormats vymaz format bunka Range("B20").ClearFormats
Copy kopiruj bunka Range("B20").Copy
Cut vyjmi bunka Range("B20").Cut
Delete odstran bunku bunka Range("B20").Delete
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Find najdi bunka Range("B20").Find

Formula vloz vzorec bunka Range("B20").Formula

Paste vloz obsah schranky | bunka Range("B20").Paste

Select vyber bunka Range("B20").Select

Sort zorad' bunka Range("B20:B25").Sort

SetFocus prejdi na tento ComboBox ComboBox1.SetFocus
prvok

Formatovanie buniek
Ak chceme zafarbit bunku, tak mdzeme pouzit:

ActiveCell.Interior.Color = 36 ' Zafarbi aktualnu bunku bledo
oranzovou farbou (vid tabulka farieb nizsie)

alebo

Range ("Al:A6") .Interior.Color = RGB (200, 160, 35) ' Zafarbi bunky v
rozsahu Al azZz A6

Poznamka: Formdatovanie buniek neexistuje vo funkcii, iba v makre!
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Praca s formularom
Menu Insert > UserForm
Pouzijeme na tvorbu pouzivatelskych formularov

i File Edit View | Insert | Format Debug
M- & g > Procedure...

Project - VBAProject UserForm 5
#% Module

LLM =]

== L4

Class Modul
#-& Solver (SOLVERXI & Class Module
: VBAProject (PERS File...

Zakladom je prazdny formular, do ktorého postupne pridavame (napr. tahanim) formularové prvky

(Controls)
= Microsoft Visual Basic for A
% File Edit View |Inset Format Debug PRun Tools Add-lns  Window Help
ME-E + a3 9 » 1 a HFY R Q
Project - VBAProject X
! ! _I UserForm1
=l -

Toolbox
&b Solver (SOLVER.XLJ

-84 VBAProject (PERSC  conirols I

-2 VBAProject (protex

-5 Micosoft Excel OF | kA abl

Sheetl (Sheet _
EB vV &

Sheet2 (Sheei E8 ¥ =

-3 ThisWorkbook  [] — =3 _'j

El@ Modules 4 a3 .
ﬁé Module1 o =] —I
LS8 Module2

[.];ﬁ VBAProject (Vlastna funkcia na SUM.xls)
E1-£5 Microsoft Excel Objects

Harok1 (Harok1)

Harok2 (Harok2)

Harok3 (Harok3)

=& VBAProject (Vypli k - FOR.dk
-2 Microsoft Excel Ob
Harok1 (Harok1)

Harok?2 {Harok2)

Harok3 (Harok3) o
< B — e .

Properties - UserForm1

L%

IUseanrml UserForm

Alphabetic | Categorized I

UserForm1 ~
BackColor [] aHzo00000F
BorderColor W =H=0000
BorderStyle 0 - fmBorde
(Caption UserForm1
Cyde 0 - fmCydeAllFor
DrawBuffer 32000 Immediate
Enabled True I
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Prazdny formular — vkladdme formularové polia
Formularové polia — Label, Textbox, Combobox, ListBox, CheckBox, ...

3. Vlastnosti — zobrazuju atributy a vlastnosti jednotlivych ¢asti formulara (napr. Name,
Caption, Font, Color a podobne )

4. Vlavo vidime nazov vytvoreného formulara

Aby sme formular z prostredia Excelu mohli otvorit , vloZime formularové tlacidlo typu Command

Button v skupine ActiveX Controls.

HHd9-¢-30&=

m_ Haome Insert Page Layout Formulas Review View Developer
Q= 3 Record Macro = M = Properties iEE_ T M
= =3 {5 Use Relative References il = ==m - Sl view Code 1 Bp

Visual Macros Add-lns  COM Design Source .
Basic A Macro Security Add-Ins Mode # Run Dialog "I R
Code Add-Ins Form Controls
n2 - | =Hv s=Ee
HYE ‘ -
A B c D e |14z 2 abldH H |

ActiveX Controls
= AR
2y = 5

Command Button (ActiveX Control)

Insert a command button control.

L W pa

Na vloZené tlacidlo klikneme 2x, ¢im sa dostaneme do prostredia Microsoft Visual Basic for
Applications. Dvojklikom sme vlastne vytvorili udalost (Click), do ktorého zapiseme nasledovny kdd:

Private Sub CommandButtonl Click()
UserForml . Show
End Sub

Zatvorime okno Excel VBA a priamo v Exceli deaktivujeme Upravu tla¢idlom Design Mode.

Data Review View Developer
|'.;T—~;'_1 M [®F Properties izg_ o !
X | En Gl view Code e
Insert [Design Source
- ﬂ Run Dialog : i A
Cotlapols

Vysledok:



E-mail I

1
% UserForm1 H
1 o .
— Aktivuj formular
| & | Menao Ii
6
L Priezvisko I
8
9|
10
11
12
13
14

Dodatoc¢né informacie

Do6veryhodné umiestnenia pre makra:
jednotka\Program Files\Microsoft Office\Templates
jednotka\Program Files\Microsoft Office\OfficeXY\Startup

Zabezpecenie makra pred jeho apravou heslom

V Microsoft Visual Basic IDE je potrebné prejst do menu:

Tools —-> VBAProject properties -> Protection atam:

Lock project for viewing (po potvrdeni kédu je vhodné zavriet a znovu otvorit zosit)

VBAProject - Project Properties “

General Protection

—Lock project

¥ Lock project for viewing;

—Password to view project properties

Password I =

Confirm password I -

K Frusit’ Pomocnik
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Export makra

V Microsoft Visual Basic IDE je potrebné prejst do menu:

File —-> Export file (uloZisubor s priponou .bas). Jedna sa o textovy subor

Import makra
V Microsoft Visual Basic IDE je potrebné prejst do menu:

File -> Import file (ndjstsubor s priponou .bas).Jednd sa o textovy stbor

Poznamky

Ako oznacit’ celt tabul'ku
Range ("A1l") .CurrentRegion.Select

Ako vlozit vzorec do aktualnej a definovanej bunky
Sub wvzorecl)

' wzorec Macro

ActiveCell = "=Al1+42" ' wvysledok vlioZi do aktualne oznacensj bunky
Range ("H3"™) = "=50UM(B1:B3)" " wvysledok wvloZfi do bunky H3
End Sub

Relativne adresovanie
Zvaime nasledovny priklad

Sub wzorec|)
L]

' wzorec Macro

' scita bunku o dvE riadky hore a jeden stlpec vlavo + bunku o riadok hore a jeden stlpec wvlavo
ActiveCell.FormulaRI1IC1l = "=R[-Z2]C[-1]+R[-1]C[-1]"

End Sub

Priklad vlastne spotita obsah bunky o dva riadky hore a jeden stipec viavo + bunku o riadok hore a
jeden stipec vlavo

Syntax: RC — row, column (riadok, stipec)

Absolutne adresovanie Vysvetlenie

R1C1 Al

R3C3 c3

Relativne adresovanie

R1C Prvy riadok, v tom istom stipci

RC1 Ten isty riadok, prvy stipec

RC[-2] Pozicia dve bunky vlavo od aktuélneho riadka a stipca

RC[+3] Pozicia tri bunky vpravo od aktudlneho riadka a stipca

R[-2]C[-1] Pozicia dva riadky hore a jeden stipec vlavo od aktuélne oznacenej
bunky
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Ako premenovat graf
Sub vytvorGraf ()

vytvorGraf Macro

ActiveSheet.Shapes.AddChart.Select

ActiveChart.ChartType = x1lColumnClustered

ActiveChart.SetSourceData Source:=Range ("'stipcovy graf'!$B$4:SES11")
ActiveChart.Parent.Name = "graf"

End Sub

Praktické odkazy

www.stackoverflow.com — vyborné férum

www.mrexcel.com — férum zamerané na Microsoft Excel

http://www.excel-easy.com/ - postupy ako pracovat s MS Excel vysvetlené jednoduchym postupom

http://www.techflutter.com/functions.php - praktické ukazky pouZzitia jednotlivych funkcii v MS Excel
VBA aj na stiahnutie

https://msdn.microsoft.com/en-us/library/office/ee861528.aspx - referencia na oficialny web
spolo¢nosti Microsoft ohladom prikazov v Excel VBA

Ulohy

Zadania:

e Spravte makro na priemer napr. troch hodnét

e Vypocet obsahu obdlznika

e Vypocditajte obvod obdiZnika

e Vytvorte vypocet DPH nad nejakou Ciselnou hodnotou.
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